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About this Guide 

This User’s Reference Guide describes how to install and configure the Nortel Meridian Desktop TAPI 32-bit TSP.  
Information in this document is intended for use by MCA/CTIA users, telephony server administrators, and 
developers who are responsible for installing, configuring, maintaining and using the MCA/CTIA with the Desktop 
TAPI for Service Provider.  This document is written based upon the assumption that you have some experience 
working with computers, TAPI, telephony products, and Microsoft Windows.  In this guide, the Meridian 
Communications Adapter is referred to as the MCA and the Computer Telephony Interface Adapter is referred to 
as the CTIA.  The “Desktop TAPI SP for MCA” and “Desktop TAPI SP for CTIA” are both referred to as the 
TAPI Service Provider (TSP) or just the Service Provider. 

Note:  The Desktop TAPI for MCA software contains a README.TXT file.  This file provides information not 
available when this document was printed.  Always read this information prior to beginning installation.  

This guide is divided into the following chapters and appendices: 

Chapter 1, “Overview,” provides a summary of the Meridian Desktop TAPI 32-bit TSP packages, Computer 
Telephony (CT) Enablers, and Microsoft’s TAPI. 

Chapter 2, “Installation and Configuration,” describes in detail how to install the software. 

Chapter 3, “Getting Results” describes how to become more efficient using applications with the TAPI Service 
Provider. 

Chapter 4, “Troubleshooting,” provides information on how to use included diagnostic utilities if you are 
having problems. 

Appendix A, “Installing the MCA,” provides additional user information that may be helpful when installing 
an MCA into an MMT series phone set. 

Appendix B, “Installing the CTIA,” provides additional user information that may be helpful when installing a 
CTIA into an M3900 series phone set. 

Appendix C, “Service Provider features,” identifies the TAPI functions supported by the Service Provider as 
well as the CLID display formats that are interpreted by the Service Provider. 

Appendix D, “Upgrading to TAPI 2.1 for Windows 95 users only”, describes a step-by-step process for 
upgrading your Windows 95 system to the 32-bit TAPI 2.1 system. 

In addition, this guide contains a Glossary that lists telephony services terms and definitions used in this document.  
A Table of Contents and Index are provided to assist you in locating the desired information.  

For additional information or help, call the Nortel Networks Developer Support Hotline at  800-4NORTEL, routing 
code 1071.  For information about other Nortel Networks products, just call (800) 4-NORTEL (466-7835).  
Outside the United States and Canada, contact your Nortel Networks Support or Sales representative. 

Note:  This document cannot be ordered from Nortel Networks using the Publication number on the inside cover 
page.  This document is only available online with the software. 
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Document Conventions 

The following conventions are used in this document: 

1. The individual keys that users are instructed to press appear inside angle brackets.   
For example: <Enter> or <F1> 

2. “Press,” “ Choose,” or “Click on” means to position the cursor over an option, then press and release the 
left mouse button to activate control and carry out an action. 

3. "Select" means to position the cursor over an option, then press and release the left mouse button to 
highlight the selection. 

4. "Double-click" means to position the cursor over an option, then press and release the left mouse button 
twice. 

5. Information that users are instructed to type appears in bold, italic print.   
For example:  Type User Id  or  Enter User Id 

6. Menu commands and options that are displayed on the window appear in bold print, such as the Exit  
option located on the File menu on the Menu bar. 

7. Window, screen, dialog box, or data entry field names display in italic print, such as, the Open field on the 
Run dialog box. 

8. “Button” refers to a click or push button displayed on the window that is clicked on or pressed to carry 

out an action.  For example:  Click on the OK  button  or  Click on  

9. “Check box”  refers to a square box displayed on the window that is clicked on to select or to clear an 
option.  For example:  �  -- option not selected  or  �  -- option selected 

10. “Option button”  refers to a circle displayed on the window that is clicked on to select or to clear an 

option.  For example:  �  -- option is not selected  or  �  -- option is selected 

11. Note: Identifies important User information and special instructions.   

Note:  Notes display in paragraphs separated from other text. 
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Related Documents 

Documents that you may need to reference, but are not necessarily required for configuring or using the Desktop 
TAPI 32-bit TSP include:   

• MS-Windows User’s Guide - Available from Microsoft Corporation. 
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Chapter 1 Overview 
 

This chapter provides an overview of the Desktop TAPI Service Providers designed for Nortel Networks digital set.  
It also contains some general information about Computer Telephony enablers and Microsoft's Telephony 
Applications Programming Interface (TAPI). 

Meridian Desktop TAPI 32-bit TSP Products 
The Meridian TAPI MCA, TAPI CTIA, Desktop TAPI 32-bit Service Provider (SP) user licenses, and Meridian 
TAPI Phone products listed in the tables below enable you to run TAPI compliant applications on your Desktop 
PC.   

The following codes products are needed to implement desktop TAPI on a Meridian M2000 series digital 
telephone: 

Product Engineering Code CPC 

MCA (M2000 Series) NT2K69AA A0682928 

MCA Transformer NPS50220-18L2 A0688664 

Meridian Desktop TAPI 2.1 Service Provider NTMN70CA A0800594 

RS232 Cable (not offered by Nortel Networks)   

Note: For Meridian M2000 series telephones with a date code prior to May 6, 1998, in addition to the MCA, these 
telephones need Jumper Kit (NT2K71AA) and ATA/MCA Footstand (NT2K83AA for M2006/M2008/M2008HF, 
or NT2K83BA for M2616/M2216ACD telephones). 

The following codes products are needed to implement desktop TAPI on a Meridian M3900 series digital 
telephone: 

Product Engineering Code CPC 

CTIA, Platinum (M3900 Series) NTMN70AA66 A0764502 

CTIA, Charcoal (M3900 Series) NTMN70AA70 A0764503 

M3900 Accessory Connection Module, Platinum NTMN71AA66 A0764507 

M3900 Accessory Connection Module, Charcoal NTMN71AA70 A0764508 

M3900 Power Transformer NTMN80AA A0779713 

Meridian Desktop TAPI 2.1 Service Provider NTMN70CA A0800594 

RS232 Cable (not offered by Nortel Networks)   

Note: If an M3900 telephone already has a Meridian Personal Directory PC Utility cartridge installed (NTMN82), 
then only the TAPI service provider software (NTMN70CA) is needed. 

Table 1-1 Desktop TAPI 32-bit TSP Products 
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Overview of Computer Telephony (CT) Enablers 

A Computer Telephony Enabler is a combined hardware/software solution that enables your PC applications to 
monitor or control a telephone in some way.  In a sense, the CT Enabler integrates your PC and telephone, allowing 
you to manage calls more effectively using your PC application.  CT Enablers can generally be categorized two 
ways: third party and first party. 

Third Party CT solution 

A third-party solution (Figure 1-1) is quite complex and requires the configuration of both hardware and software 
on the switch, as well specific LAN configurations at each PC.  Although the advantage to this configuration is the 
centralized management of the CT enabler, it is difficult to cost justify and deploy on a person-by-person basis. 

 

Switch 

CT enabling 
hardware 

CT Server 

LAN 

 

Figure 1-1 Third Party CT enabling solution 

First Party CT solution 

In contrast, a first party solution (Figure 1-2) will have a hardware/software combination that attaches an individual 
phone to a single PC.  Each PC must have the appropriate CT enabling hardware/software in order to be CT 
enabled.  Although this usually requires the addition of some CTI hardware to the phone itself, the installation is 
simple and can be deployed on a person-by-person basis.  In most cases, an individual user can install a first party 
solution without any impact or intervention by a LAN or switch administrator. 
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CT enabling 
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Switch 

 

Figure 1-2 First Party CT enabling solution 

The Nortel Meridian Desktop TAPI 32-bit TSP product is an example of a first party CT enabling solution.  The 
CT enabling hardware, which is attached to the phone, is either an MCA or a CTIA depending on your phone set 
type.  The CT enabling software, written specifically for each device, is called a Service Provider and is designed 
to work with Microsoft’s TAPI architecture. 
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Overview of TAPI 
The introduction of new Computer Telephony Integration (CTI) standards allows businesses of all sizes to develop 
new applications integrating computers and telephone systems.  Microsoft and Intel created the Telephony 
Application Programming Interface (TAPI).  This technology integrates computers with the telephone network.  
 

 

Microsoft’s TAPI system 

Outlook ACT! TAPI 
application 

Telephony API  (TAPI) 

Service Provider interface 

TAPI SP for 
CTIA 

TAPI SP for 
MCA 

Universal 
MODEM SP 

 

Figure 1-3 Microsoft’s TAPI architecture 

 
The Nortel Meridian Desktop TAPI Service Providers, available as standalone development kits, can be included in 
a variety of applications. TAPI gives developers a consistent set of tools for creating the windows-based telephony 
applications.  By programming to a standardized API, applications can be written without regard to a specific 
hardware type or switch vendor.  The hardware vendor merely provides a Service Provider (SP) and the user is able 
to monitor and control their phone using any standard TAPI-compliant application. 

 
Microsoft's Operating System and TAPI software have evolved over the years and understanding which releases 
are compatible with Nortel Network's Desktop TAPI Service Providers is important.  Refer to Table 1- below. 
 

Microsoft 
Platform 

TAPI 
system 

Desktop TAPI 
SP version 

Windows 3.1 1.3 1.6* 
Windows 95 1.4/2.1** 1.6*/2.0/2.1 
Windows 98 2.2 2.0/2.1 
Windows NT 4.0 2.1 2.0/2.1 
Windows 2000 3.0 2.0/2.1 

Table 1-2 TAPI Service Provider compatibility 

*This guide does not cover the installation and configuration of the 1.6 versions of the Desktop TAPI product, which is no longer supported by 
Nortel Networks. The Desktop TAPI 2.0 has been replaced with version 2.1. 

 

**Windows 95 is delivered with  Microsoft’s TAPI 1.4 and must be upgraded to  Microsoft’s TAPI 2.1 before using the 32-bit TSP products.  
See Appendix D for details. Note that Mi crosoft’s TAPI 2.1 for Windows 95 is not the same as the Nortel’s Desktop TAPI 2.1 Service Provider 
also referred to as the Desktop TAPI 31-bit TSP. Both are needed to make this application work on Windows 95. 
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The Desktop TAPI 32-bit TSP Product is a first-party TSP for Digital Sets connected to the Meridian 1.  Nortel 
Networks also offers other first and third party TAPI SPs for Meridian 1, Norstar, MSL-100, and DMS Meridian 
Digital Centrex business systems. 
 

What kind of hardware do I need? 

Whether you need an MCA or CTIA depends on the telephone set type that you have.  The MCA is designed for 
the Meridian 2000 series below and Orion series of Nortel Networks digital phone sets, while the CTIA is designed 
for the newer M3900 series sets.  See Table 1-2 below.  

Telephone Type Models Interf ace 

Meridian 2000   

 

M2006 
M2008        
M2216 
M2616 

MCA     
MCA    
MCA    
MCA 

Orion M3110 
M3310 
M3820 

MCA    
MCA    
MCA 

Meridian 3900 
 

M3902        
M3903        
M3904        
M3905 

CTIA 
CTIA 
CTIA 
CTIA 

Table 1-2 CT Enabling hardware 

Both the MCA and CTIA devices also require an appropriate power supply to operate.  See the Appendixes for 
more details specific to each device. 

What does a TAPI Service Provider do for me? 

TAPI compliant applications usually support placing calls, answering calls, holding and un-holding calls, 
transferring and conferencing calls, as well as other features.  However, one of the most important functions of the 
TAPI Service Provider is interpreting the information that is presented to the telephone set’s display and passing 
that information on to a TAPI application.  

The Meridian Desktop TAPI 32-bit TSP is specifically designed to capture this information and deliver it in a 
unified format to TAPI applications.  There are several applications that offer Computer Telephony Integration 
(CTI) solutions, such as Microsoft's Outlook 97.  Refer to Chapter 3 “Getting Results” for more information on 
getting the most of Outlook and other TAPI applications. 

For a detailed listing of all of the TAPI functions supported by the Service Provider, see Appendix C. 
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Chapter 2 Installation and Configuration 
 

This chapter contains instructions and information for installing and configuring the Desktop TAPI 32-bit TSP 
software.  The information in this chapter assumes that you have already installed the MCA or CTIA device 
into the phone set and have verified that it is properly powered.  If one of these devices is not already installed, 
refer to Appendix A for detailed information about installing an MCA into an MMT series set, or Appendix B 
for detailed information about installing a CTIA into an M3900 series set. 

A note to Windows 95 users 

If you are running Windows 95, please see the special notes about upgrading your system to TAPI 2.1 for 
Windows 95 users only in Appendix D. 

A note to Windows NT and Windows 2000 users 

If you are running Windows NT or a version of Windows 2000 you must be logged on with an account that has 
Administrator privileges in order to install and configure the software. 

Upgrading from an earlier version 

Due to conflicts with having multiple Service Provider files, earlier versions of the Service Provider must be 
removed before installing a new version.  If you are upgrading from version 2.0 or 2.1, the installer will 
automatically uninstall any earlier versions as needed after prompting the user.  

Desktop TAPI SP for MCA (version 2.0) 

If you have previously installed the product “Desktop TAPI SP for MCA”, the installer will automatically 
uninstall the earlier version and remove the Service Provider from the Telephony configuration.  All of the 
program links to “Desktop TAPI SP for MCA” will be removed and replaced by “Desktop TAPI 32-bit TSP”.  
You will then have to manually add the Service Provider to the Telephony configuration using the Telephony 
icon in the Windows Control Panel. 

Desktop TAPI 32-bit TSP  (version 2.1) 

If you have previously installed the product “Desktop TAPI 32-bit TSP”, the installer will automatically 
upgrade your current installation.  If the Service Provider is part of your current Telephony configuration, and 
you are still using the same phone and interface device pair, you will not need to make any changes to the 
Service Provider configuration. 
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Minimum PC Hardware and Software Requirements 

Before you install and configure the Desktop TAPI 32-bit TSP software, you should become familiar with the 
PC system hardware and software requirements, hardware configuration and connectivity as described in this 
section. 

Always be sure to read the latest release notes and README.TXT files that came in your package before 
attempting to install any software. 

Minimum Hardware Requirements 
The minimum hardware requirements for the Desktop TAPI 32-bit TSP include: 

• 486/66 MHz  
• 16 MB of RAM is recommended.  Also check the application requirements. 

Memory - the amount of memory needed by the Desktop TAPI for MCA to run depends on the 
interface device being used, according to the following list: 

MCA  196 KB 
CTIA  208 KB 

Note:  These values increase as the number of DNs and features assigned to the set increases, but never by 
more than 25%. 

• The amount of free disk space that is needed depends upon the installation options you select: 2 MB of 
free disk space is needed for the minimum installation, while 4 MB of free space is required for the 
complete installation, including Diagnostic Tools, and online documents.  Additional free disk space is 
required for running TAPI applications.  Refer to the appropriate TAPI application document for 
information regarding additional disk space needed for the application. 

• Mouse (optional, but strongly recommended for installation) 
• An available COM port with an external DB-25 or DB-9 connector. 
• VGA or SVGA display 
 
 

Note:  Lower system speeds and lower memory capacities may adversely affect system performance.   
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Minimum Software Requirements 

The minimum software requirements for the Desktop TAPI 32-bit TSP include: 

• Windows NT 4.0 SP4/ SP5 
• Windows 2000 
• Windows 98 
• Windows 95 using Microsoft TAPI SP 2.1 software* 

 
 

*Note:  The Desktop TAPI 32-bit TSP product can only be used with Windows 95 if the TAPI 2.1 upgrade, 
available from the Microsoft support site, has already been installed.  See Appendix D, for more information. 

Minimum PBX and Switch Equipment Requirements 

This section describes and illustrates the telephone and switch related components needed for the installation of 
the Desktop TAPI 32-bit TSP on M1 Option 11C through 81C PBXs.  Included are the necessary software 
releases, line cards, telephones, and interface devices supported.  Required cabling is also listed. 

Meridian 1/SL-1 PBX requirements  

Although the telephones and interface devices listed are, by themselves, compatible with both the Meridian 1 
and the MSL100 switch environments, the Desktop TAPI 32-bit TSP software is designed to work with the 
SL1/Meridian 1 only.  Please contact you switch administrator to assure that your phone is attached to an SL1 
or Meridian 1 PBX.   

Switch Software Releases 

The software release required:  

• for Meridian SL-1 -- X11 Release 14 or greater 
• for Meridian 1 Option 11 --  X11 Release 16 or greater 
• for Meridian 1 Option 21-81  -- X11 Release 15 or greater 

Note: The M3900 CTIA requires X11 Release 25.40 or greater. If the Conference and Transfer features of 
the TAPI 2.1 Service Provider are not to be used, then X11 Release 25, 25.10, 25.15 or 25.30 can also be used. 

Line Cards 

One of the following line cards is required. 

• NT8D02AB and above Digital line card in an IPE module 
• QPC578 Digital line card in a PE module 

Telephones Supported 

The following Meridian Modular Telephones are supported: 

• M2006 
• M2008 
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• M2216ACD-1 
• M2216ACD-2 
• M2616 

The following Orion Telephones are supported only in Europe: 

• M3110 
• M3310 
• M3820 

The following M3900 series Telephones are supported with X11 Release 25 and greater: 

• M3902 
• M3903 
• M3904 
• M3905 

Cables 
• A PC Serial/Modem with either DB-9 to DB-25 or DB-25 to DB-25 connectors is needed. The 

connector end for the MCA and CTI is a DB25. The other end should match the connector on your PC. 
The cable should be straight through and should not crossover any connections. 

Interface Devices 
• Meridian Communications Adapter (MCA). 

• Computer Telephony Interface Adapter (CTIA) 

 

Before you install 

This section describes the procedures that must be performed to successfully install the Desktop TAPI 32-bit 
TSP product .  Prior to installing this software, you should have certain hardware, software, and PBX 
configurations in place.  These pre-installation configurations are detailed in the following checklist. 

Pre-installation Checklist 

Before installing the software, complete the following pre-installation checklist. 

1. Verify that your PC meets the minimum hardware and software requirements defined in the 
“Minimum PC Hardware and Software Requirements” section in this chapter. 

2. Verify that your telephone and PBX are of the supported types found in the “Minimum PBX and 
Switch Equipment Requirements” section of this chapter.  

3. Verify that your  telephone is operational and has at least one DN key to support dialing and 
answering calls from the TAPI application. 

4. Determine which telephone features your TAPI application will need to use, and then verify that 
these features are assigned to your set.  You can examine the feature keys on your telephone set 
while working with your telephone system administrator to verify that your phone is set up 
properly to support your TAPI application. 

5. In the following table, circle the appropriate telephone and interface device pair that you will be 
using. 
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Telephone Type Models Interf ace 

Meridian Modular  

 

M2006 

M2008 

M2216 

M2616 

MCA 

MCA 

MCA 

MCA 

Orion M3110 

M3310 

M3820 

MCA 

MCA 

MCA 

Meridian 3900 M3902 

M3903 

M3904 

M3905 

CTIA 

CTIA 

CTIA 

CTIA 

Table 2-1 Telephone and Interface selection 

 

6. Check an available COM port that has an external connector on your PC. 

 

COM Port 

� � Com1 

� � Com2 

� � Com3 

� � Com4 

  

� � Other   

   

Table 2-2 PC COM port selection 

 

7. Using Table 2-3 below, record the directory numbers (DNs) that appear on your telephone set, and 
any name you would like to associate with each DN.  Although the Service Provider will assign 
default values for these items, you may want to use names that your telephone system has already 
associated with the DNs.  If you have an Incalls key, you may want to use the ACD Agent position 
ID and Queue name.  These descriptions will be used later when you configure the Service 
Provider using the Telephony icon in the Windows Control Panel. 

 

 

Key Telephone DN Name 

   

   

   

Table 2-3 Directory Numbers (DNs) on your set 
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Note:  Although the Desktop TAPI 32-bit Service Provider is not designed to monitor or control DNs that 
appear on add-on (KBA or DBA) modules, you may still have the add-on modules attached to your 
telephone set and operate the keys manually.  

 

8. If your interface device is a CTIA, skip to step 9. 

a) Ensure that your MCA is correctly installed and that there is power by looking at the red 
LED next to the DB-25 connector at the back of the phone set.  It should be flashing at a 
slow, steady rate. 

b) Enter the following Program key sequences from your set: 

1) Press the Program key on your telephone, enter 67, select Unlock using the 
volume bar, and press the Program key. (Unlock the MCA) 

2) Press the Program key, enter 65, and press the Program key. (Reset the MCA) 
3) Press the Program key, enter 22, enter 2400 for the baud rate, and press the 

Program key. (Change the baud rate) 
4) Press the Program key, enter 20, and press the Program key. (Asynchronous 

mode) 
5) Press the Program key, enter 34, and press the Program key. (Force DTR on) 
6) Press the Program key, enter 66, and press the Program key.(Select Modem 

emulation) 
7) Press the Program key on your telephone, enter 67, select Lock using the 

volume bar, and press the Program key. (Lock the MCA) 

9. Attach one end of the serial cable to the DB-25 connector on the back of your phone and attach the 
other end to the appropriate COM port on your PC.  You are now ready to install the Desktop 
TAPI 32-bit TSP software. 
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Installing the Desktop TAPI 32-bit TSP Software 

The Desktop TAPI 32-bit TSP software is on a CD ROM that comes with the MCA or CTIA.   

The online documents are available, uncompressed, on the CD ROM.  If you choose to install the online 
documentation, it will be displayed in the Desktop TAPI SP 32-bit TSP program group. 

Prior to installing the Desktop TAPI for MCA software, ensure the Pre-installation checklist (located in the 
“Before you install” section in this chapter) is complete.   

Note:  Before starting the Meridian Desktop TAPI 32-bit TSP software installation, close any TAPI 
applications that are running.   

To Install from the CD ROM: 
1. Insert the CD ROM that contains the Desktop TAPI 32-bit TSP installation software in the CD ROM drive. 

2. Click on the Start button and Select Run. 
The Run dialog box is displayed. 

3. Type the path for the CD ROM followed by TAPI32\setup.exe in the Run dialog box. 
For example:   
E:\TAPI32\Setup.exe 

4. Click on the OK  button.  The installation process begins.  Follow the instructions in the dialog boxes as 
they are displayed.  The section “The Installation process” details some of the important steps that may 
require input from the user.  

The Installation process 

Before the actual installation of the Meridian Desktop TAPI 32-bit TSP software, the installer checks your 
system for any previous installations and also checks to see whether the Service Provider is currently part of the 
Telephony configuration.  Depending on the version currently installed, you may be prompted to automatically 
uninstall the earlier version, change your current telephony configuration, or both.  If you do NOT want the 
installer to do either of these automatically, click “No” when prompted, and the installer will quit. 

Once the pre-installation checks have finished, you can complete the Installation by following the direction in 
the dialog boxes.   

1. The Welcome screen is displayed.  After reading the information on the Welcome screen, click on the Next 
button to continue the installation.   

2. The Software License Agreement dialog box is displayed.  Read the License Agreement and click on the 
Yes button to accept the terms of the License agreement and continue the installation.   
Or 
Click on the No button to cancel the installation. 

3. The User Information screen is displayed.  Enter your Name and Company name in the fields provided. 

4. The Choose Destination Location dialog box is displayed.  Click on the Next button to accept the default 
directory 

Or 
Click on the Browse… button and enter or select a new path name. 
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5. The Setup Type dialog is displayed.  Click on the Next button to install the default Typical setup. 

Or 
Click the Radio button to select the type of Setup you prefer: 

o Typical  Installs all of the Service provider files and all of the diagnostic utilities, but does NOT 
install the online documentation. 

o Compact Installs only the Service Provider files. 

o Custom  Defaults to all of the files, including the online documentation, but provides additional 
dialogs to allow the user to select the specific files desired.  De-selecting files for 
installation should only be done by experienced users who have a need to tailor the specific 
files that get installed. 

Click on the Next button to continue. 

6. The Select Program Folder dialog box is displayed.  Click the Next button to select the default folder name 

Or  

Enter a new program folder to create 

Or 
Select an existing program folder to use 

Click on the Next button to continue.    

7. The Check Setup Information dialog box is displayed, which summarizes the information gathered during 
the install.  If everything is correct, click the Next button to finish the installation, or Back to make any 
necessary changes. 
  

8. The Setup dialog box displays the status as the files are being installed. 

9. The Setup Complete screen notifies you that the installation is almost complete and prompts you whether to 
display the README file. 

10. Click on the Finish button to finish the installation.  If you chose to display the README file, a window 
will open displaying the contents of the README file.  You may close this window when you are done 
reading the information. 

You are now ready to configure the Service Provider. 
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Configuring the Service Provider 

The installation of the “Meridian Desktop TAPI 32-bit TSP” software simply copies the necessary files to your 
system.  In order to use the Service Provider with TAPI applications, you must first add the Service Provider to 
your Telephony configuration.  Then you need to configure the Service Provider using the information you 
collected in the section titled “Before you install - Pre-installation Checklist”.  You complete all of these 
configurations by using the Telephony applet in the Windows Control Panel. 

Accessing the Windows Telephony Control Panel  

Although the method of accessing the Telephony Control Panel, as well as some of the dialogs and icons may 
vary between Windows 95, Windows NT, and Windows 2000, the basic concepts are still the same.  The 
dialogs specific to the Desktop TAPI 32-bit Service Provider will be the same on all platforms. 

Windows 95 Telephony configuration 

You can access the Telephony configuration by clicking Start -> Settings -> Control Panel then double-
clicking the Telephony ICON. 

 

Then click on the Telephony Drivers tab. 
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Windows NT 4.0 Telephony configuration 

You can access the Telephony configuration by clicking Start -> Settings -> Control Panel then double-
clicking the Telephony ICON. 

 

Then click on the Telephony Drivers tab. 

 

Windows 2000 Telephony configuration 

You can access the Telephony configuration by clicking Start -> Settings -> Control Panel then double-
clicking the Phone and Modem options ICON. 

 

Then click on the Advanced tab. 
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 Note: At the time of this writing, Windows 2000 was still in BETA.  Some names and methods may change by 
the time Windows 2000 is available. 

 

 Adding the Service Provider to the Telephony configuration 

Before you can configure the Service Provider, you must add it to the Telephony configuration. 

Refer to the interface device listed in your selection in Table 2-1 Telephone and Interface selection”.  If your 
interface device is an MCA, you will be using the Service Provider named “Desktop TAPI SP for MCA”.  If 
your interface device is a CTIA, you will be using the Service Provider named “Desktop TAPI SP for CTIA”.  
If you do not see the appropriate Service Provider listed in the dialog displayed in the previous step, Click on 
the Add… button. 

The Add Driver dialog appears displaying the Service Providers that you can add to your system.  If you chose 
a Custom install, and chose NOT to install either of the Service Providers, only the ones you did select will be 
shown here.  If the Service Provider that you need is not listed here, you will need to run the install again.  
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Select the appropriate Service Provider based on your interface device and click the Add… button.  If the 
Service Provider is successfully added to the Telephony configuration, the Service Provider configuration 
dialog box appears.  You can now configure the Service Provider. 

Adding a new device configuration 

When the Service Provider is added for the first time, no device Names or ComPort settings will be shown 

 

To add a device configuration, click the New button.  This will display the device configuration Wizard. 
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Enter a name for this device configuration.  You can choose any name that identifies the phone/device pair or 
just click Next to accept the default.  TAPI will use this name as the unique identifier for this phone/device pair. 

Next, choose the COM port that you selected from Table 2-2 PC COM port selection in the “Before you install - 
Pre-installation Checklist” section.  The list will only display ports that are valid COM ports on the system.  If 
you need to choose a COM port that is not listed, check to make sure that your Windows system has the port 
configured. 

Once you select a valid COM port, click on the Finish button.  This will return you to the main Service 
Provider configuration dialog.  You should now see the new device configuration in the list. 

 

Click the Close button.  This will return you to the main Telephony Control Panel dialog.  Wait for the OK  
button to change to Close, and then click the Close button.  No additional configuration is required to allow 
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TAPI applications to use the Service Provider to monitor and control your phone; however, you may still want 
to perform some additional configurations to tailor the Service Provider for your environment. 

Tailoring your Service Provider Configuration 

Once you have successfully associated your phone/device pair with a COM port, you may need to supply some 
additional configuration information based on your phone set’s Class Of Service settings as well as the name 
and number information you supplied in Table 2-3 Directory Numbers (DNs) on your set” phone set. 

1. Start the Service Provider configuration using the Telephony Control Panel the same way you did in 
the “Accessing the Windows Telephony Control Panel” section earlier in this chapter. 

2. Click on the Telephony Drivers Tab.  You should see either the “Desktop TAPI SP for MCA” or 
“Desktop TAPI SP for CTIA” in the list. 

 

3. Select the appropriate driver, and click the Configure button.  You should see the Device Name and 
COM port that you selected earlier with an OK  status.  If the status is not OK , make sure that the cable 
is connected between the interface device on back of the phone and the proper COM port on the PC.  
Also, make sure the power supply for the interface device is attached properly.  If you have other 
problems, see Chapter 4, “Troubleshooting Tips” for additional information.  
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4. Select the device you would like to configure, and click the Details button.  The Service Provider 
configuration dialog appears. 

 

  Device tab 

  

 

The Device tab displays the following information: 

• Name for this Device.  In TAPI, the interface device, the phone set, and all of the DNs that are 
configured on the phone are collectively referred to as a single “line” appearance.  The name that you 
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supply here for the Device configuration is the name that TAPI will use to uniquely identify this 
phone/device combination.  In TAPI applications, this is the name that will appear when you are 
presented with a choice of which TAPI lines it should use. 

• ComPort.  This is the COM port that you selected when you created this device configuration. 

• Switch Type.  This is the switch type that the Service Provider detected.  Currently, the SL1/Meridian 
1 is the only switch type supported. 

• Line Type.  This is the phone set type that the switch has configured for this line.  Although with the 
MMT series phone sets, the actual phone set attached does not have to be the same as what is 
configured in the switch, with the M3900 series, the attached phone set must be the same as the switch 
configuration. 

DNs/Addresses tab 

 

The DNs/Addresses tab displays the following information: 

• Key.  This is the number of the “DN” key on the phone as configured in the switch.  In TAPI, each DN 
key that is recognized by the Service Provider (InCalls, SCR, SCN, MCR, MCN) is represented as an 
individual “address” appearance.  If a key is not listed, it is not recognized by the Service Provider as a 
“DN” key. 

• Number.  This is the dial number that is associated with this DN. 

• Name.  This is the name that is associated with this DN. 

In TAPI, the settings for the Name and Number are used when presenting information about calls on the 
associated DN.  For outgoing calls, the associated Name and Number will appear in the Caller ID fields, while 
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for incoming calls, they appear in the Called ID fields.  The default values for the Name and Number fields 
generated by the Service Provider can be changed at any time by double-clicking on the desired entry.  This will 
display the Key dialog. 

  

Use the information from Table 2-3 Directory Numbers (DNs) on your set” to make any necessary changes.  
Click the OK  button when done, or the Cancel button to cancel any changes made in this dialog. 

Note: On the M3900 series sets, the number associated with a DN is automatically downloaded from the switch 
and, therefore, cannot be modified.  However, you can still change the name field as needed.  

Features tab 
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The Features tab displays the functional capabilities of the Service Provider.  This is not an exhaustive list of 
the complete TAPI capabilities, but rather a summary of the types of call features that the Service Provider can 
provide to TAPI applications.  In order to take advantage of these features, your TAPI application must support 
these operations as well as certain required feature keys must be programmed on your phone set.  For example, 
in order for the Service Provider to actually provide the Conference feature, you must have a conference key 
configured on the phone. 

Options tab 

 

The Options tab displays two options: 

Display – This box indicates whether or not you would like the Service Provider to automatically invoke the 
display key on your phone set to receive Calling Name and Number information for incoming calls before they 
are answered.  Checking this box indicates that you would like to enable this feature.  This feature is enabled by 
default.  You must have a display key configured on this phone set in order for this setting to have any effect. 

Reverse Lamp Flash – This box should only be checked if you have RFLA in the Class of Service for this line.  
This feature is not enabled by default, and is appropriate for most installations.  You should check with your 
Telecom Administrator before checking this box. 
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Advanced tab 

 

The Advanced tab allows you to specify the settings for the Reason values.  These values are used by the 
Service Provider to attach appropriate reasons for calls that are redirected to/from this line.  By default, these 
settings match the default values on the switch.  If these values are not correct, contact your switch 
administrator for the correct values for the associated prompts in LD 95 and modify the appropriate fields as 
needed.  Click the OK  button to save the changes, or click on the Cancel button to cancel any changes made in 
this dialog.  Click on the Load Defaults button to reload the default settings. 
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Driver Info tab 

 

The Driver Info  tab provides copyright and Service Provider type and version information. 
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Removing the Software 

If it becomes necessary to remove Meridian Desktop TAPI 32-bit TSP software, always use the Windows 
Add/Remove feature located on the Control Panel to remove the files.   

To Remove the Software: 

1.  Select Start/Settings/Control Panel. 
The Control Panel window opens.  

2.  Double-click Add/Remove Programs. 
The Add/Remove Programs dialog box opens. 

3.  Select Meridian Desktop TAPI 32-bit TSP from the list and click Remove. 

Note: If your current Telephony configuration includes either the “Desktop TAPI SP for MCA” or the 
“Desktop TAPI SP for CTIA” Service Provider, they will automatically be removed from the 
configuration before the actual uninstall begins.  Since this requires silently starting the Telephony 
configuration in the background, it may take up to a minute before the uninstall proceeds. 

4.  The Meridian Desktop TAPI 32-bit TSP files are removed.
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Chapter 3 Getting Results 
 

Once you have CT enabled your phone by installing and configuring the “Meridian Desktop TAPI 32-bit TSP” 
products, your computer will be capable of utilizing a myriad of Telephony applications.  This chapter contains 
information on how to use some of these applications and how they can help you become more productive. 

The applications and descriptions listed in this chapter were from information available during the writing of 
this document.  Some user interface changes may occur by the time these products become available.  These 
applications were not tested exhaustively, and no endorsement of their suitability for any purpose is written or 
implied by Nortel Networks.     

 

Using the Phone Dialer Application 

The Phone Dialer is a simple TAPI Application that comes with all versions of Windows.  It makes simple 
phone calls, speed dials, and outpulses digits.  It cannot answer incoming calls. 

Setting up the Phone Dialer 

To set up the Phone Dialer application, access the Phone Dialer window and enter information on the Connect 
Using dialog box. 

 

1.  Click Start and select Programs / Accessories. 

2.  Select Phone Dialer. 
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 The Phone Dialer window opens. 

 

3.  Click Tools and select the Connect Using option. 

 

 

 
The Connect Using dialog box is displayed. 

 

  

 

4.  Click the drop-down arrow located at the end of the Line field and select a line name.  This will be the 
“device name” that you chose during configuration. 

5.  Click the drop-down arrow located at the end of the Address field and select an address.  The numbers 
available will correspond to the numbers you configured for the DN keys during configuration.  
Essentially, this allows you to place the call using any DN. 
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6.  Click OK  to close the Connect Using dialog box and save the changes. 

Using the Phone Dialer  

After setting up the Phone Dialer application, outgoing calls can be made. 

1.  From the Phone Dialer dialog box, enter digits in the Number to dial field. 

2.  Click the Dial button. 
The call is dialed. 

Speed dial buttons allow you to pre-program numbers, so that simply clicking on a button places the call  

1.  Click the Speed dial button you wish to configure. 
The Program Speed Dial dialog box opens. 

 

 

2.  Type a name and a number to dial. 

3.  Click the Save button to save the information. 
The information is displayed on the Phone Dialer window. 

4.  Program additional buttons by repeating steps 1-3. 
The configured buttons display the names you entered. 
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Additional information regarding this application is available by clicking Help on the Menu bar. 
 

Using the Phone Dialer Features of Outlook and 
Microsoft Schedule+ 

Microsoft Outlook 

If Microsoft Outlook 97 version 8.02.4212 or above is loaded on your machine, it can be used with the Service 
Provider to provide automated calling capabilities in conjunction with your Contacts list.  

The information presented here is for general purposes only and intended only as a guide in using Microsoft 
Outlook with the Meridian Desktop TAPI 32-bit TSP.  For specific Microsoft Outlook information, refer to 
Microsoft Outlook user documentation.  

Setting up Outlook 97/98 to Allow Dialing from the Contacts List 

 

1. Ensure the Meridian Desktop TAPI 32-bit TSP software is installed, configured, and working, and that 
Microsoft Outlook 97/98 is loaded on your machine. 

2. From the Contacts folder within Outlook, go to the Tools menu and select Option.   
The Options dialog box opens. 
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3. Click the Dialing Option… button. 
The Dialing Options dialog box is displayed. 

  

4. Click the arrow located to the right of the Connect using line drop down list box to display the options.  

5. Select your TAPI line instead of the modem.   

6. Make any additional changes to the Dialing Properties. 

7. Click OK  to save the changes and close the Dialing Options dialog box. 

Using Outlook 97/98 to Dial from the Contacts List  

 

1. Click Tools located on the Menu bar and select the Dial / New Call option or right click a Contact and 
use the autodialer.   

2. Click the Start Call  button to place your call. 
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Using Outlook 2000 to Dial from the Contacts List 

No special setup is required to allow dialing from the Contacts List; however, you may want to open the Dialing 
Options dialog to select the appropriate Line and Address to use. To configure the Line and Address, follow 
these steps: 

1. Click Contacts . 

2. On the Actions menu, point to Call Contact, and then click New Call. 

3. Click Dialing Options, and then click Line Properties. 

4. On the tabs at the top of the window, select the connection options you want.  
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Using Other TAPI Applications 

The Meridian Desktop TAPI 32-bit TSP products support many TAPI Applications.  The following sections list 
some that have been verified for basic functionality and highlight the important tasks that can be performed 
with each application. 

Resource Software Int’l Ltd. (RSI) Rapport for TAPI  

RSI Rapport for TAPI  is a Desktop Telephony Interface, developed by Resource Software International Ltd. 
(RSI), that seamlessly integrates telephony control into the user’s 32-bit desktop environment.  Rapport allows 
control of telephone activity directly from a desktop PC.  Highlights of this application are: Call Control 
(answer, hold, transfer, unhold, conference), Hotkey Dialing, Caller ID integration, and a Non-intrusive call 
handling metaphor integration with customer relationship management applications. RSI Rapport for TAPI 
provides complete TAPI integration with the entire Windows Environment.  

Rapport for TAPI integrates with virtually any Windows application to perform screen pops and outbound 
dialing. As an example, a travel agency with a proprietary customer database could use Rapport for TAPI to 
receive screen pops at each agent’s desktop and access the details of each customer’s travel plans. 

Robust Call Control 

 

Contact Relationship Management Database Integration 

RSI Rapport for TAPI has an established database of links to popular commercial packages for simple setup, 
but users can easily configure their own.  RSI Rapport for TAPI also provides developers with numerous 
telephony features for easy integration into environments where custom software has been implemented. 

Hot keys may be defined to perform specific functions.  For example: A
user could define <Control F11> as a Global Dial HotKey.  Regardless
of the application the user is in, if they highlight a telephone number and
press <Control F11> the call is placed. RSI Rapport for TAPI provides
HotKeys for Application & Global Dialing as well as Hang Up and
Answer. 

Keyboard macros allow RSI Rapport for TAPI to emulate what a
person would type to get to a telephone number, copy the number and
dial it. These keystrokes are easily defined by the user and can be
configured to work with virtually any Windows application. 

Drag and Drop Dialing allows users to highlight a phone number in an
application, then simply drag it into Rapport to place the call. 

Once enabled, the user is not restricted to using only RSI Rapport for
TAPI.  They can still manually use their phone set and the RSI Rapport
for TAPI software, or they can use just RSI Rapport for TAPI.  RSI
Rapport for TAPI is always aware of the attached telephone set’s
state and allows the user to switch back and forth seamlessly. 
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One of Rapport’s strongest attributes is the ability to send Caller ID information to as many as five applications, 
either automatically or on demand, based on user-selectable options.  If one caller needs to be looked up in Act! 
And the next caller needs to be looked up in an accounting package, RSI Rapport for TAPI can do it. 

Standard Features  

Rapport for TAPI also allows access to standard telephone set features of the Meridian Desktop TAPI 32-bit 
TSP such as:  Hold, Unhold, Answer, Transfer, Conference  & Hang Up. 

Setting up Rapport  
Refer to the RSI Rapport for TAPI User Guide for procedures on how to configure which line appearances 
you want the application to control. 

                

 

To learn more about RSI Rapport for TAPI and other products offered by Resource Software International Ltd.  
either visit their web site at http://www.telecost.com or contact them at: 

Resource Software International Ltd. 
40 King Street West, Suite 300 
Oshawa, Ontario, Canada, L1H 1A4 
Phone: (905) 576-4575  

Fax: (905) 576-4705 

ActiveVoice PhoneMax 2.0  

PhoneMax is Active Voice's first standalone telephony product.  It gives TAPI users complete control over all 
telephone activity right from their PC. With an integrated Call Log and PIM (Personal Information Manager), it 
can also use information from personal databases and other applications.  
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Setting up PhoneMax 2.0 
 

1. After starting the PhoneMax Application, click the Setup button on the active window. 

2. Click the TAPI  radio button 

3. Use the down arrow located to the right of the Name field and select a TAPI Line Name. 

 

4. Double-click OK  to save the changes and close the dialog box.  

Using PhoneMax 2.0 

The figure below is a sample user interface for the PhoneMax 2.0 application.  Refer to the PhoneMax 2.0 User 
Guide for details. 
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To find out more information about PhoneMax visit Active Voice’s web site at http://www.activevoice.com/ . 

Amicus Attorney 3.0  

Amicus Attorney is a TAPI application designed for Law offices. It makes calls, answers calls, holds and 
unholds calls, outpulses digits, times calls, and logs calls.  

Setting up Amicus Attorney: 
1.  Access the Amicus Attorney main window. 

2.  Click File and select Setup. 

3.  Click the Phone Tab to display the Phone Call Management options. 
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4. Set up your Telephony Line/Device and address. 

5. Click the OK button. 

Using Amicus Attorney 

 

1. From the main window, click the Phone icon in the lower right corner of the window. 

2. Either select an address entry or enter a new number in the Phone field. 

3. Click the Phone icon to make a call. 

 You can use the Stop / Clock icon to time the call. 

To view the log: 

Click Show Log. 

To find out more information about Amicus Attorney visit the web site at http://www.amicus.ca/ .
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Chapter 4 Troubleshooting 
This chapter contains information about resolving problems with your Meridian Desktop TAPI 32-bit TSP 
installation.  It describes some of the additional diagnostic utilities that are included with the product as well as 
a list of some possible problems and the actions to resolve these problems. 

Note: The following displays and descriptions detail a configuration that utilizes an MCA for the interface 
device and the “Desktop TAPI SP for MCA” service provider.  Although the actual screen displays may vary 
slightly depending on whether you are using the “Desktop TAPI SP for MCA” service provider or the “Desktop 
TAPI SP for CTIA” service provider, the discussion and problem resolutions apply to both configurations.  Any 
exceptions will be noted. 

Service Provider Configuration problems 

The Service Provider’s control panel is a quick indicator of the communication status between the Service 
Provider, the COM port, the interface device, and the switch.  This should be your first check when you are 
having problems.  Normally, when everything is connected and configured correctly, the status will be OK . 

 

Note: The method of getting to the Service Provider’s control panel varies slightly between various versions of 
Microsoft Windows 95/98/NT/2000.  See the configuration section of Chapter 2, “Accessing the Windows 
Telephony Control Panel” for platform specific instructions. 

If the status is OK  and you are still having problems, go to the section “
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TAPI Application problems” later in this Chapter. 

Status New or Changed 

This indicates that this is a newly created device configuration or there have been changes in an existing device 
configuration; however, since TAPI has not been allowed to restart, the Service Provider has not been able to 
use the new configuration.  Exit the Telephony Control Panel completely, and close all TAPI applications.  If 
you are unsure of whether or not any TAPI applications are still running, you may want to reboot your system 
to be sure. 

Status Fail 

The Fail status can be caused by several things such as: 

• Selected COM port is invalid 

• Selected COM port is busy 

• Interface device is not communicating 

• Unable to determine switch type/invalid switch type 

 

For more information on the specific reason for a failure, select the device and click on the Details button to 
bring up the Diagnostic wizard.   Depending on the error, the first panel will display one of the following 
reasons: 
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Specified resource is invalid 

 

This is an indication that the COM port selected for this configuration does not exist on the system at this time.  
You may find that COM ports that were valid at one time may not be available at a later time due to changes in 
system hardware, I/O and IRQ settings, or BIOS settings.  Click the Next button to select a valid COM port, or 
check your Operating System COM port settings to re-enable the selected COM port.  
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Specified resource is in use 

 

This is an indication that the COM port selected for this configuration is valid; however, it is currently in use by 
some other application.  Check the Control Panel to see if there is a Modem configured on the selected COM 
port.  If so, remove it.  Even if the modem is not actually connected, TAPI will open the COM port and attempt 
to initialize the Modem. 

Verify that no other COM applications are configured to use the selected COM port.  

Device is not responding 

This is an indication that although the selected COM port is valid and the Service Provider was able to open the 
port for its own use, the device that is connected to the specified COM port does not appear to be responding to 
the initialization request. 

The following sections describe some possible remedies for this error based on the type of interface device you 
are using.  If one of the remedies applies to your situation, you should correct the problem and then allow TAPI 
to restart by exiting the Telephony Control Panel and closing all TAPI applications.  If you are unsure of 
whether or not any TAPI applications are still running, you may want to reboot your system to be sure.  
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If your interface device is an MCA 

 

Figure 4-1 MCA not responding error 

• Verify that the serial cable is properly connected between the MCA on the back of the phone and 
the selected COM port of the PC. 

• Verify that you have properly powered the MCA.  The red LED on the back of the phone should 
be flashing at a slow steady rate. 

• Try resetting your MCA.  Press the Program key on your telephone, enter 22,  then press the 
Program key. 

• Verify that you have configured the MCA data parameters correctly. 

1. Press the Program key on your telephone, enter 67, select Unlock using the volume bar, 
and press the Program key. (Unlock the MCA) 

2. Press the Program key, enter 65, and press the Program key. (Reset the MCA) 
3. Press the Program key, enter 22, enter 2400 for the baud rate, and press the Program 

key. (Change the baud rate) 
4. Press the Program key, enter 20, and press the Program key. (Asynchronous mode) 
5. Press the Program key, enter 34, and press the Program key. (Force DTR on) 
6. Press the Program key, enter 66, and press the Program key.(Select Modem emulation) 
7. Press the Program key on your telephone, enter 67, select Lock using the volume bar, 

and press the Program key. (Lock the MCA) 

• You may have an MPDA or an out–of–date MCA.  See Appendix A for details about the correct 
MCA part numbers. 
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If your interface device is a CTIA 

 

Figure 4-2 CTIA not responding error 

• Verify that the serial cable is properly connected between the CTIA on the back of the phone and 
the selected COM port of the PC. 

• Verify that you have properly powered the interface device. 

Note: The wall mounted power supply required to power a CTIA in an M3900 series phone set is 
different than the one used with an MCA in an MMT series set.  See Appendix B for the correct power 
supply part numbers. 
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TAPI Application problems 

Since it is difficult to predict how an average TAPI application might respond when the Service Provider does 
not initialize properly, always verify that the Service Provider control panel status reads OK .  If it is not OK , or 
you do not know how to verify the status, see the section “Service Provider Configuration problems” earlier in 
this Chapter. 

Once you have verified that the Service Provider status is OK , you can use some of the diagnostic tools that are 
included as part of the Meridian Desktop TAPI 32-bit TSP product. 

Note:  If you chose a “Typical” installation all of the following diagnostic tools were automatically copied 
during installation.  If you chose a “Compact” installation or a “Custom” installation and deselected the 
diagnostic tools, they were not copied.  You can copy them manually from the distribution media, or rerun the 
installation. 

The TAPI Test Application 

Note:  The JulMar TAPI Phone Dialer is provided to Nortel Networks by JulMar, Inc.  Information and product 
updates on the TAPI Phone Dialer are provided on the JulMar web site (http://www.julmar.com/samples.htm 
look for PHONE).   

The TAPI Phone Dialer program from JulMar Technology Inc. is a standard TAPI 2.x compliant application 
that is copied to your PC when you install the Meridian Desktop TAPI 32-bit TSP software.  This test 
application can be used to verify that the installation and configuration steps have been completed properly and 
that your PC is ready to support TAPI applications. 

By running the TAPI Phone Dialer program, you can answer, make and drop calls, place calls on hold and take 
them off hold, transfer and conference calls using the same methods your TAPI applications use.  The call 
information is displayed in fields and is useful when dealing with customer support.  The procedures below 
describe how to use the TAPI Phone Dialer to verify the operation of the Service Provider: 

1. Click Start and select Programs\ Desktop TAPI 32-bit TSP 

2. Select the Test Application program.   
The TAPI Phone Dialer program window opens. 
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Note:  Individual feature buttons at the bottom of the window are enabled only when the Service 
Provider is capable of providing that feature at that time.  The capabilities of a call will change as the 
state of the call changes and it is the responsibility of the Service Provider to notify applications about 
these changes.  Good TAPI applications should indicate to users which features are possible at any 
point in time.  

 

3. Click the down arrow located next to the Device field and look for the name you chose when you 
created the device configuration. 

4. Click the down arrow located next to the Address field and select the DN to control or monitor.  If you 
did not associate specific numbers using the DNs/Addresses configuration tab in the Service Provider 
control panel, the addresses will default to numbers like: “0000”, “0001”, etc. 
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5. Click Start Session . 

6. Enter a number in the Phone # field and click Make Call. 

    

 
The phone goes off-hook and dials the number automatically.   

7. After the far end answers, click Hold.  The call is put on hold and the indicator beside the DN on the 
set flashes. 

8. Click Unhold.  The call is taken off hold and the indicator beside the DN key on the set stops flashing. 

9. Click Hangup.  The call is disconnected. 

10. From another telephone, place a call to your DN.  While the phone is ringing, click Answer . Verify 
that the following information is correct: Call State, Call Type, Call Direction, Caller ID, Called ID, 
Connected ID, and Redirecting ID. 

11. Click End Session  to close the TAPI Phone Dialer program window. 

Unable invoke certain features from TAPI application 

If you are having a problem with a TAPI application not allowing some feature that you think should be 
available, try using the TAPI Phone dialer application and see if the feature works with it.  If it does, then it’s 
possible that there is a TAPI compliance problem with the application.  If it does not, then perhaps it is a feature 
that is not supported by the Service Provider, or the required keys have not been assigned to the phone set. 

TAPI Applications Do Not Display Correct Information 

If you are having a problem with the Caller ID information displayed by your TAPI application, the JulMar 
TAPI Phone Dialer can also be used to determine what kinds of information the Service Provider is sending to 
TAPI applications.  Many TAPI applications only display what is in the TAPI Caller and Called fields; 
however, there are 5 different fields available to relay detailed Name and Number information about a calls 
origination, destination, redirection, and current connection.  It is possible that the information you are 
expecting to see is in a field that is not displayed by your application.  If you see the information you are 
looking for in one of the fields displayed by the TAPI Phone Dialer, you should contact your application vendor 
and find out how to use the information found in the “other” TAPI fields.  

 

 

Logger Utility 

Occasionally, problems occur that cannot be easily found by simply running the TAPI application normally.  
Under the direction of Nortel Networks customer support personnel, the Nortel Logger utility can be used to 
capture messages from the TAPI Service Provider.  Although the information collected is of little use to the end 
user, the log file created by the Logger utility can be very helpful to the support staff. 
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Note:  You must setup the message filter settings when running the Nortel Logger utility for the first time. 

Setting the message filters 

In order to limit the number and content of the messages captured, the Logger utility allows the user to tailor the 
message filters as needed, depending on the problem they are trying to resolve.  You can access the filter 
settings from the menu item Settings -> Filter  then selecting on of the following items: 

 

Default – This sets the filters to a known “typical” state.  This is usually good enough for most situations. 

Add-ins – Allows the addition of more detailed classes of messages 

 

Note: These are truly “add-in” filters.  This means that checking a box simply adds additional filters to 
the current filter settings; leaving a box unchecked does NOT remove any filters.  If you need to 
remove any filters, you need to go back to the default settings, or use the Advanced option.   

Advanced – Allows the finest detail of filter settings.  Individual event types for every module can be turned on 
or off.  Also allows individual filters to be flagged with specific colors.  This should only be used under at the 
direction of the Nortel Networks customer support staff.  

Capturing a Logger file 

Once the message filter parameters are set, the Nortel Logger displays the specified messages from the Service 
Provider in its main window.  When the Nortel Logger 32 window is full, the messages are automatically 
appended to an overflow file.  By default the overflow file is named “Overflow.txt” and is created in the same 
folder as the Nortel Logger utility.  
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If you are asked by the Nortel Networks support staff to capture a Logger file, follow these steps: 

1. Start the Logger utility. 

2. Make sure the filters settings are set correctly (if unsure, select Filter ->Default from the Settings 
menu). 

3. Get your system ready to produce the problem, but do not exercise the problem scenario yet. 

4. Clear the current window of messages by selecting “Clear All”  from the Edit  menu. 

5. Clear the current overflow file by selecting “Clear overflow file”  from the File menu. 

6. Now, exercise the problem scenario. 

7. When the messages for the problem scenario have been captured, append the messages in the window 
to the overflow file by selecting “Append to overflow”  from the File menu. 

8. Exit the Logger utility to avoid capturing unintended messages to the overflow file. 

9. Find the “Overflow.txt” file in the folder where the Logger was installed and send it to the Nortel 
Networks support staff.  Do not edit this file, or modify it in any way. 

Other features 

Although you probably will not need to make any other configuration changes in the Nortel Logger 32 
application, here are some additional features that you may find useful. 

Logger Window options 

You can access additional Logger window options by selecting “Options”  from the Settings menu. 

 

Note: Do NOT change the Pipe name unless specifically directed by Nortel Networks support staff! 

If you check the “Logger window on top”  checkbox, the Logger window will always be visible on top of all 
other application windows. 
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You can also change the Font displayed in the Logger Window by selecting “Font” from the Settings menu. 

Logger toolbar 

 

The Nortel Logger 32 window is a standard Windows Edit window and allows the entire set of standard Edit 
features from both the “Edit”  menu and the toolbar: 

• Undo 

• Cut, Copy, Paste 

• Select All, Clear All 

• Find, Find Next, Replace 

The  button toggles the capture of data to the Logger window.  This allows you to take a closer look at the 
data that is currently in the Logger window.  Since this completely stops the collection of messages, and will 
create gaps in the data sent to the overflow file, it should not be used while attempting to collect a Logger file.   

The status pane at the bottom of the Logger window indicates whether or not the message capture is active.  The 
state of the message capture is NOT saved when you quit the Logger application, and is always set to active 
when the Logger application is started. 

 

Figure 4-3 Logger message capture is active 

 

Figure 4-4 Logger message capture is NOT active 
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Appendix A Installing the MCA 
 
This Appendix contains instructions and information for installing and configuring the Meridian 
Communications Adapter (MCA) in preparation for its use with the Meridian Desktop TAPI 32-bit TSP 
product. 
 

Telephone Compatibility  

The MCA is forward and backward compatible with the following Meridian Modular Telephones: 

• M2006 
• M2008 
• M2008HF 
• M2616 
• M2216ACD 

The MCA is also compatible with the following European (Orion) Digital Sets: 

• M3110 (European) 
• M3310 (European) 
• M3820 (European) 

Note: These sets may require additional parts and installation steps.  Contact your distributor or local 
reseller for part numbers and instructions.  

   

What is an MCA? 
The MCA is a printed circuit board that is installed into the foot stand of an MMT series digital telephone and 
allows personal computers to connect to the Meridian Modular Telephone, using an RS-232C interface and a 
DB-25 connector. 

Exclusions  

• Due to UL and CSA considerations, digital telephones equipped with an MCA cannot be wall 
mounted. 

• The wall mount knockout located on the bottom of the telephone foot stand must be intact. 

 

Note:  For safety reasons, if the wall mount knockout is damaged or missing, you must replace the foot 
stand with a new one before installing the MCA. 
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What else do I need? 

This section covers some details that you should review before installing an MCA.  It describes other related 
hardware you may need and whether you need to upgrade or replace any existing equipment. 

Manufacture date codes 

Although the MCA can be installed into any all of the phones listed above, the manufacture date of your phone 
set will determine some of the steps involved.  Telephone sets manufactured after February 6,1998 show a 
Warranty Start Date of 05/06/98 on the set label on the back of the phone.  See Figure A-1 for the location of 
these codes.    

 

Figure A-1 Telephone set label with Warranty Start Date code 

Table A-1 summarizes the vintages of phone sets.  Phone sets with a Warranty Start Date of 05/06/98 or later 
have the appropriate foot stand and Jumper kit already installed.  If you have a set with an earlier date, you must 
install these items in the field. 

Pre MCA MCA Ready Required MCA 
Hardware 

NTZK  NT2K 
Prior to 
April 1998 

NT2K 
Later than 
April 1998 

NT9K 

Internal Jumper (NT2K71AA) �  �  Pre-installed Pre-installed 

Redesigned foot stand �  �  Pre-installed Pre-installed 

24/8 VAC power adapter �  �  �  �  

Table A-1 Required Hardware for the MCA 
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Internal Jumper 

All phone sets must have two internal power jumpers installed before installing the MCA.  As shown in Table 
A-1, the MCA Ready phone sets (dated 05/06/98 or later) already have this jumper installed.  If you have an 
earlier phone set (dated earlier than 05/06/98), you will need to order the jumper kit NT2K71AA. 

MCA compatible foot stand 

These foot stands have tab cutouts for the DB25 and power connectors in the back.  As shown in Table A-1, the 
MCA Ready phone sets (dated 05/6/98 or later) are equipped with MCA/ATA compatible foot stands. 

 

Figure A-2 MCA compatible foot stand w/ cutouts 

   

Note: You cannot use a foot stand designed for the newer style MCA if you plan to use a Key Expansion 
Module (NT2K22) with your M2616 or M2216ACD. 

Power 

In order to operate, your MCA must be properly powered.  The power is supplied by a 24/8 VAC wall 
transformer that plugs directly into its own connector on the back of the foot stand.  Depending on the 
manufacture date of your phone set, you may also need to apply a jumper kit.  See Table A-1 Required 
Hardware for the MCA” for details. 

Note:  Different power supply options were used with some earlier MCA/MPDA devices that applied 26.7VAC 
to the outer pair of the phone’s line cord either by a wall transformer or a closet power supply such as 
Shumway.  Although these power options can still be used when installing the older style MCA, these are NOT 
compatible with the newer style MCA, which must receive power through the connector on the back of the foot 
stand. 

 

MCA Installation 

Introduction 

This section gives a step-by-step approach to installing the MCA into your phone set.  The basic steps are 
outlined here, followed by additional details as noted.  
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Caution:  Before handling internal set components, static electricity must be discharged by touching any 
grounded metal surface. 

Note: Do not wall mount a telephone with MCA installed. The wall mount knockout located on the bottom of 
the telephone foot stand must be in place. If this knockout is damaged or missing you must replace the foot 
stand with a new one before installing the MCA. 

1. Be sure you have all of the required hardware.  Refer to the “What else do I need?” section. 

2. Disconnect and remove all cords (including the handset cord) from the telephone. 

3. Place the telephone, upside-down, on a padded level surface. 

4. Remove the two screws that connect the foot stand to the telephone base.  If the foot stand has the tab 
cutout for the MCA/ATA, remove the MCA cutout.  If your foot stand does not have the cutout, 
discard it and use the new MCA/ATA foot stand. 

5. If you have an MCA Ready phone (dated 05/6/98 or later), skip to the next step.  If your phone set is 
dated prior to 05/06/98, apply the internal jumpers.  See the section “Installing the internal jumpers,” 
for details. 

6. Install the MCA into the foot stand: 

a. Tilt the MCA printed circuit board so that the DB-25 connector fits into the cutout section. 
b. Lower the board into position on the bottom of the foot stand. 
c. Secure the board using the screws provided. 

7. Plug one end of the short 8-conductor line cord, provided with the MCA, into the data jack in the base 
of the telephone. Plug the other end of this cord into connector J1 on the MCA. 

8. Reassemble the foot stand onto the base using the two screws you removed earlier. 

9. Reconnect all cords, including the handset cord and new 24/8 VAC wall transformer.  Verify that your 
MCA is properly installed and powered by checking the status of the LED next to the DB-25 connector 
on the back of the phone: 

a. If it is flashing at a slow, steady rate (approx. 1 flash/sec) it is ready to be programmed. 
b. If it is flashing with 2 rapid flashes followed by a short pause, the phone’s line cord is not 

attached. 
c. If you do not see any light all, the MCA is not powered properly.  Recheck steps 5-7.     

10. Locate the label that was included with the MCA, and place it on the telephone base close to the 
existing set label for future tracking purposes. 

11. Finish the installation by configuring your MCA.  See section “Configuring the MCA” later in this 
Appendix. 

Installing the internal jumpers 

Telephones with a Warranty Start Date code 05/05/98 and earlier require an ATA/MCA Jumper Kit 
(NT2K71AA) to be field installed before installing an MCA.  Two jumpers are included in the ATA/MCA 
Jumper Kit.  See Figure A-3.  The Jumper with the Black connector referenced below is designed for use with 
NT2Kxxxx or NT9Kxxxx telephone vintages.  The Jumper with Brown connector is designed for use with 
NTZKxxxx vintage telephones.   
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Figure A-3 ATA/MCA Jumper Kit 

1. Remove the back covering of the telephone base (four screws). 

2. If the telephone is equipped with a Power Supply board and/or cable, you must remove them before 
installing the MCA.  Refer to Figure A-4 below. 

a. Remove the two screws from the Power Supply board and set them aside. 
b. To remove the Power Supply board from the NTZK telephone, grasp the board on each side 

and rock it while applying upward pressure, until it is released. 
c. To disconnect the Power Supply board from the NT2K telephone, lift the board out of the set 

and disconnect the ribbon cable from the 2X7 pin connector. 

3. If the telephone is equipped with the External Alerter board, you must remove it before installing the 
MCA. The External Alerter board is located inside the telephone base right of center. Refer to Figure 
A-4 below. 

a. Remove the screws from the External Alerter Interface board. 
b. Grasp the board firmly on each end and pull upward to remove it from the 2X3 pin connector. 

 

Figure A-4 Power board and External Alerter detail 

4. Place the jumpers as shown in Figure A-5.  Note that you will be using only one of the jumpers: The 
jumper with the Black connector is used with the NT2K and NT9K set only; the jumper with the 
Brown connector is used with the NTZK set only. 

 



 

Meridian Desktop TAPI 32-bit TSP 
Reference Guide Installing the MCA •••• A-64 
 

 

Figure A-5 Internal jumper placement 

5. Your phone set is now MCA Ready.  You can finish with the MCA installation. 

Configuring the MCA 

The Meridian Communications Adapter (MCA) can be used for various applications including passing 
synchronous and asynchronous data through the Nortel Networks PBX system.  This section shows you how to 
program your MCA for use exclusively as an interface device for Computer Telephony.  When used in this 
manner, it cannot be used for other applications.  The following configuration steps must be completed before it 
can be used for CT enabling using the “Meridian Desktop TAPI 32-bit TSP” product. 

Program the MCA Using the Keypad 
1. Verify that the red LED at the rear of the telephone set is flashing at a slow steady rate. 
2. Enter the following Program key sequences from your set: 

 
a. Press the Program key on your telephone, enter 67, select Unlock by using the volume bar, and 

press the Program key again.  (Unlock the MCA data parameters) 
b. Press the Program key, type 65, and press the Program key. (Reset the MCA) 
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c. Press the Program key, type 22, enter 2400 for the baud rate, and press the Program key. 
(Change the baud rate) 

d. Press the Program key, type 20, and press the Program key. (Asynchronous mode) 
e. Press the Program key, type 34, and press the Program key. (Force DTR on) 
f. Press the Program key, type 66, and press the Program key. (Select Modem emulation) 
g. Press the Program key, type 67, select Lock, and press the Program key. (Lock MCA) 

 
3. Your phone is now ready to be used with the “Meridian Desktop TAPI 32-bit TSP” product.  
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Appendix B Installing the CTIA 
The M3900 Series Computer Telephony Integration Adapter (CTIA) provides an interface between M3900 
Series telephones (M3902, M3903, M3904, and M3905) and your PC for first party call control applications. 

Your PC connects to the CTIA through an RS-232-C serial cable. The CTIA is a small cartridge that fits into 
either slot on the Accessory Connection Module (ACM). The ACM connects to the M3900 Series telephone 
through a 20-pin cable and a foot stand. The telephone connects to a T-adapter, which connects to both a 
telephone line and a power transformer (NTMN80AA). The transformer plugs into an electrical outlet.  

 

 

How to install the 
CTIA 

1. Ensure that an Accessory Connection Module (ACM) is 
properly installed in your M3900 Series telephone (refer to 
the ACM Installation Sheet for details). 

2. Insert the CTIA accessory cartridge into either the small or 
large port on the ACM. The cartridge must be face up with 
latch on top, as shown above. 

3. Connect an RS-232-C serial cable to the PC and the CTIA. 

Note: The RS-232-C serial cable is not included with your 
CTIA. The cable must have a male DB25 connector to 
interface with the CTIA. The other end must be terminated 
with a connector that mates with the connector on the back of 
your computer. Contact your Nortel Networks local 
distributor for recommended RS-232-C cables. 

RS-232C pin 
Requirements 

Pin Function Description 
2 TX Transmit 
3 RX Receive 
4 RTS Request to Send 
5 CTS Clear to Send 
6 DSR Data Set Ready 
20 DTR Data Terminal Ready 
7 GND Ground Signal 
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Appendix C Service Provider features 
This section describes the features designed into the TAPI Service Providers that are included as part of the  
“Meridian Desktop TAPI 32-bit TSP” product. 

TAPI functions supported by the Service Provider 

• lineAccept • lineAddToConference  

• lineAnswer  • lineBlindTransfer  

• lineClose  •  lineCloseCall  

• lineCompleteTransfer • lineConfigDialog  

• lineDial  • lineDrop 

• lineGenerateDigits  • lineGetAddressCaps  

• lineGetAddressID  • lineGetAddressStatus  

• lineGetCallAddressID • lineGetCallInfo 

• lineGetCallStatus • lineGetDevCaps 

• lineGetDevConfig • lineGetExtensionID 

• lineGetID • lineGetLineDevStatus  

• lineGetNumAddressIDs • lineHold 

• lineMakeCall • lineNegotiateTSPIVersion        

• lineOpen • linePrepareAddToConference      

• lineSetDefaultMediaDetection • lineSetDevConfig                

• lineSetStatusMessages • lineSetupConference             

• lineSetupTransfer  • lineSwapHold                    

• lineUnhold • lineSetCurrentLocation          

• lineConfigDialogEdit  
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CLID Display formats supported by the Service Provider 

The Service Providers only interpret the number information that appears on the bottom line of the phone set’s 
display.  DNIS, when it appears on the top line, is not captured or interpreted.  The Calling ID and Called ID 
information delivered to the TAPI application follows these supported display formats. 

• General format numbers can have the f ollowing fo rmats: 

-- xxxx   // All digits 

-- Hxxxx  // H immediately followed by digits only until WS 

-- Hxxx-xxxx // H immediately followed by digits separated by a single dash until WS 
 

• General format numbers for both incom ing an outgoing calls 

-- Format1: xxxx 

-- Format2: xxxx yyyy 

-- Format3: xxxx reason 

-- Format4: xxxx yyyy reason 
 

• Incoming call fo rmats 

-- All numbers must contain only valid digits 

-- Format11: xxxx-xxxx   // Trunk 

-- Format12: xxxx-xx-yyyy  // Trunk + DNIS, yyyy=DNIS 

-- Format13: xxxx-xx-yyyy zzzz  // Format12 + ACDQ, zzzz=ACDQ 

-- Format14: xxxx-xx-yyyy zzzz reason // Format13 + reason 

-- Format15: xxxx-xxxx yyyy  // Trunk + ACDQ 

-- Format16: xxxx -yyyy   // Caller + DNIS, yyyy=DNIS 

-- Format17: xxxxx-yyyy   // Caller + DNIS, yyyy=DNIS on DASS trunks 

 

• Outgoing call fo rmats 

-- All numbers must contain only valid digits 

-- Format21: xxxx-yyyy   // xxxx = ACDQ, yyyy = Agent Position  

-- Format22: zzzz xxxx-yyyy  // zzzz = Dialed DN + Format21 

-- Format23: xxxx-yyyy reason  // Format21 + reason  

-- Format24: zzzz xxxx-yyyy reason // Format22 + reason 

 

Note: If the Service Provider is unable to match the actual display to one of the above formats, it will default to 
copying digits from the beginning of the bottom display line up to, but not including, the first non-digit 
character and placing the result into the CallerID field for incoming calls; for outgoing calls, the result is copied 
to the CalledID fields. 
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Appendix D Upgrading to TAPI 2.1 for 
Windows 95 users only 
Note: Nortel has compiled the information contained in this chapter for informational purposes only.  This 
information is not a procedure, but a supplement to the Microsoft TAPI Readme.txt file that is provided by 
Microsoft.  Be sure to read the Microsoft TAPI Readme.txt file and install according to those instructions.   

Microsoft TAPI version 1.4 and version 2.1 

All retail copies of Windows 95 were originally delivered with the version 1.4 of Microsoft’s Telephony 
Applications Programming Interface (TAPI) system.  The 1.4 version is a 16-bit system and must be upgraded 
to Microsoft TAPI 2.1 in order to support 32-bit Service Providers like those found in the “Meridian Desktop 
TAPI 32-bit TSP” product.  

If you are installing the “Meridian Desktop TAPI 32-bit TSP” product on Windows 98, Windows NT, or 
Windows 2000, you do not need to upgrade your TAPI system, other than assuring that you have the latest 
Service Packs installed.   

Upgrading Microsoft TAPI 2.1 

The Microsoft TAPI 2.1 upgrade is available via Microsoft’s Web page.  Use the following link to retrieve the 
TAPI 2.1 upgrade, or contact your Microsoft Support personnel. 

ftp://ftp.microsoft.com/developr/TAPI/TAPI2195.zip 

Note:  Do NOT use this upgrade on Windows 98, NT 4.0, or Windows 2000.  Upgrading to Microsoft 
TAPI 2.1 is not necessary for the Windows NT Server and Windows NT clients; however, you should 
have Microsoft Service Pack 4 or above installed. 

 

Reinstalling the Older Version of Microsoft TAPI 

If you wish to uninstall TAPI 2.1 and return to Microsoft’s TAPI 1.4 , on a Windows 95 client only, follow the 
following steps: 

1.  Locate the remtapi.inf file. 

2.  Right click on the correct file and select the Install  option. 

Note:  When using the remtapi files, you may have to copy the Telephon.cpl file back into the Windows\system 
directory.  


